System 5 and Pro Tools® Guide
**Legal Notices**

This guide is copyrighted ©2011 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.


Bonjour, the Bonjour logo, and the Bonjour symbol are trademarks of Apple Computer, Inc.

Product features, specifications, system requirements, and availability are subject to change without notice.

**Guide Part Number** 9329-65158-00 REV B 08/11

**Documentation Feedback**

At Avid, we are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.
## Chapter 1. Introduction

- System Requirements .................................................. 1
- About This Guide ....................................................... 2
- About www.avid.com .................................................. 4

## Chapter 2. Software Configuration

- Rename the Pro Tools Workstation ............................... 5
- Startup Sequence ......................................................... 6
- Enabling EUCON in Pro Tools ....................................... 7

## Chapter 3. Track and Session Basics

- Basics ........................................................................ 10
- Assigning Pro Tools Tracks to Console Strips ................. 10
- Layouts ........................................................................ 11
- Using the Transport ...................................................... 12
- Navigating Through a Session ..................................... 14
- Fader Strip Controls .................................................... 14
- Track Basics ............................................................... 15

## Chapter 4. Recording ..................................................... 17

## Chapter 5. Plug-Ins and Sends ................................. 19

- Working with Plug-In Inserts ...................................... 19
- Working with Sends ..................................................... 21

## Chapter 6. Automation and Mixing ............................ 23
Avid’s EUCON™ (Extended User Control) adapter enables fully integrated control of Pro Tools® from EUCON-compatible work surfaces, including System 5.

This guide explains how to enable EUCON™ (Extended User Control) in Pro Tools 9.0 or higher and control Pro Tools from your System 5.

System Requirements

The features described in this guide require the following:

- Avid System 5 Digital Audio System
- Pro Tools or Pro Tools HD version 9.0 or higher
- EUCON Workstation and eMix software (version 5.0 or higher)

For downloads and other resources, visit:

www.avid.com/proseriessupport

Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices for Pro Tools, visit:

www.avid.com/compatibility
About This Guide

This guide explains how to enable EUCON and use System 5 with Pro Tools.

The following resources are also available:

- For complete information on your System 5, see the electronic PDF version of the System 5 User Guide.
- For additional EUCON software setup and configuration information, see the EUCON Application Setup.pdf.
- For instructions on connecting and configuring Pro Tools, see the software installation and hardware user guides that came with your Avid system. For information about using Pro Tools software, see the Pro Tools Reference Guide (in Pro Tools, choose Help > Pro Tools Reference Guide).
Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font. The names of hardware keys on System 5 are in bold (such as Wave).

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

妮 Shortcuts show you useful keyboard or mouse shortcuts.

➡️ Cross References point to related sections in this and other Avid guides.
About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on the User Conference.

💡 For Artist Series support, visit www.avid.com/artistsupport. For Pro Series, visit www.avid.com/proseriessupport.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Avid or sign up for a Pro Tools demo.
chapter 2

Software Configuration

Before you proceed, make sure you have completed the following:

- Installed Pro Tools or Pro Tools HD version 9 or higher
- Installed the current version of EUCON Workstation software (provided with the eMix application) onto the Pro Tools workstation
- Confirmed the installation of your System 5 hardware and eMix v5.0. or higher
- Confirmed that your other DAWs (such as Nuendo) are updated to the correct versions

Rename the Pro Tools Workstation

Before proceeding, it is highly recommended that you give each workstation a unique name. This is recommended to avoid confusion when attaching workstations to the System 5, and to be able to more easily identify exactly which workstation is or is not attached to the system.

**Mac** On Mac, you rename the workstation by editing the “hostconfig” file in the “etc” folder (which is a hidden folder). See “To rename a Mac workstation:” on page 5.

**Windows** On Windows, you can rename the workstation in the Properties window for your computer. See “To rename a Windows 7 workstation:” on page 6.

**To rename a Mac workstation:**

1. From the Finder, choose Go > Go To Folder (or press Command + Shift + G on your computer keyboard).

2. Type /Etc/ (slash, Etc, slash).

3. Click Go (or press Enter). The etc folder appears.

4. In the etc folder, find hostconfig and drag it to your desktop.

5. From the desktop, double-click on hostconfig.

6. Add the following line at the bottom of the list, or modify the entry if it already exists:

   HOSTNAME=my_name_here (where “my_name_here” is the desired name for the workstation)
7 Save the file and drag it back to the etc folder, replacing the original.

8 When you reboot, the new name will appear. This is the name you will see within System 5 when you attach the workstation.

**To rename a Windows 7 workstation:**

1 Go to Start > Computer.

2 Right-click on Computer and choose Properties.

3 In the section Computer name, domain, and workgroup settings, click Change Settings.

4 Make sure the tab Computer Name is selected; if it is not, click the tab Computer Name.

5 Click Change in the section To rename this computer or change its domain or workgroup.

6 Enter a new name for the workstation into the Computer name field.

7 Click OK.

---

**Startup Sequence**

**To start up System 5 and Pro Tools:**

1 With all system components turned off, turn on the Ethernet switch and allow it to complete its startup diagnostics.

2 Turn on the SC264 System Computer and all I/O units.

3 Double-click the eMix icon on the desktop.

4 Turn on all Surface Modules, the CO600 Changeover Switch (if present), and the DF66(s) or DF70.

5 Do one of the following, as appropriate:

   • If system modules have been saved as default, eMix continues to boot when all modules reach 100%. If no modules appear as *Unexpected*, click Continue to finish booting eMix. The startup sequence is now complete.

   • If any modules appear as Unexpected, go to “Resolving Unexpected Modules” on page 7.

   ![On Hybrid systems’ SC264, confirm that EUCON Discovery is set to use the second LAN connection and that it is not on the System 5 connection.](image)
Resolving Unexpected Modules

To resolve any modules that appear as Unexpected during startup:
1 Control-click each Unexpected module until all are selected.
2 Click Save selected as default, and confirm the selection by clicking OK.
3 Click Continue to finish booting eMix.

⚠️ When eMix launches, the control surface is temporarily disabled and audio is muted. Launching eMix automatically by putting it in the Windows Startup folder may produce undesirable behavior if the System Computer reboots during a broadcast or session.

💡 On Hybrid systems’ SC264, confirm that EUCON Discovery is set to use the second LAN connection and that it is not on the System 5 connection.

4 Power up the workstation computer running Pro Tools.
5 Power up the workstations running other DAWs (if any).
6 Follow the instructions in “Enabling EUCON in Pro Tools” on page 7.

---

Enabling EUCON in Pro Tools

To enable EUCON control in Pro Tools:
1 Make sure MC Client and EUCON Discovery software are running.
2 Launch Pro Tools.
3 Choose Setup > Peripherals, and click the Ethernet Controllers tab.
4 Select Enable EUCON.
5 Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON.

💡 Using System 5 with Pro Tools version 8.x and lower utilized the HUI (MIDI Controller) protocol. This is no longer necessary with Pro Tools 9.0 and higher.

Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When Pro Tools finishes scanning your system, your controllers are ready to use with Pro Tools.

**Confirm Installation**

**To confirm installation and communication:**

1. Make sure you have enabled EUCON as explained in “Enabling EUCON in Pro Tools” on page 7.
2. Open a Pro Tools session if one is not already open.
3. On the System 5 CM401 Main Panel, select EUCON Setup and attach to your Pro Tools workstation. (If you do not know how to attach a workstation, see “Attaching the Pro Tools Workstation to System 5” on page 10.)
4. Verify the Pro Tools Mix window displays a blue-green border around all Pro Tools tracks.

![Color outlines in the Mix window showing currently-banked tracks](image)

5. Verify that the CM401 Main Panel EUCON channels display the correct Pro Tools tracks.

💡 See the Pro Tools Installation Guide for system optimization recommendations.
This chapter provides examples of the following:

**System Basics** Basics for System 5 Projects and Titles for use with Pro Tools, including how to attach a Pro Tools workstation to the system.

**Layouts** How to assign Pro Tools tracks to System 5 DSP channels, and how to create a Layout.

**Using the Transport** How to use the Transport controls to play, stop, cue, record arm, and more (see “Using the Transport” on page 12).

**Banking the Faders** How to view tracks on the fader strips (see “Navigating Through a Session” on page 14).

**Fader Controls** How to adjust track volume and pan, and solo and mute tracks (see “Fader Strip Controls” on page 14).

**Track Basics** How to select tracks and assign input and output routing (see “Track Basics” on page 15).
Basics

On System 5, you first designate the drive on which you want to create and store Projects.

Projects are where you create Titles, and Titles store and recall Mixes. Titles also contain the Layouts you create (the arrangement of DAW channels across the System 5 faders and other surface controls). If you are unfamiliar with any of these concepts, see the System 5 User Guide before proceeding.

Attaching the Pro Tools Workstation to System 5

To attach the Pro Tools workstation to System 5:

1. On the CM401, press MAIN Panel to show the MAIN panel.
2. Select EUCON, then Setup. All workstations recognized on the network are listed.
3. Hold down the Workstation button (below the panel), then press the Select button to the left of the displayed name of the computer (workstation) on which Pro Tools is installed.

We recommend giving each workstation a unique name (instead of typical default names such as “Mac HD” or similar). For instructions, see “Rename the Pro Tools Workstation” on page 5.

4. The button flashes until communication has been established.

Once the Pro Tools workstation has been attached, you can assign Pro Tools tracks to console strips and save assignments as Layouts as explained in the next section.

Assigning Pro Tools Tracks to Console Strips

To assign Pro Tools tracks to the System 5 channel strips:

1. Press the Main Panel key in the center section.
2. Select EUCON, then Channels. The Channel Assign Panel appears.
3. In the Channel Assign Panel Viewer, press the key next to the channel you want to assign. (To display additional channels, press the Page keys.)
4. Activate the Main or Swap channel on the desired strip, then press its Chan Select key.
5. Repeat steps 3 and 4 to assign multiple channels.

To assign multiple, consecutive Pro Tools tracks to the console:

1. Press the Main Panel key at the bottom of the Panel Viewer.
2. Press the Channels key in the Main Panel. The Channel Assign panel appears.
3 Press the **Auto** key so that it lights.

4 Press the key next to the first desired track channel to designate it as the “starting” channel.

5 Position your finger over the **Chan Select** key for the first (left-most) fader strip you want assigned on the console. Because this technique requires a two-key sequence beginning with **Chan Select** and moving to the right to the **Swap** key, the first fader strip must be at the far left of those being assigned.

6 Begin by pressing the **Chan Select** key on the first (left-most) fader strip, but continue moving your finger to the right across to the **Swap** key on the last strip you want to assign. As you “sweep” your finger across fader strips, each **Chan Select** key should light. If one or more do not, hold any already lit **Chan Select** key and then press the ones you missed until they each stay lit.

You have just assigned the Main fader layer on each strip. Pressing the **Swap** key lets that same strip be assigned to another DAW track as follows:

7 Move your finger back to the first fader strip’s **Chan Select** key and repeat the same sequence of key presses.

This maps the next series of DAW tracks to the Swap layer on the same strips that you previously assigned via its Main layer. For example, if the first sequence mapped tracks 1–8 to the Main layer on eight fader strips, the second sequence would map tracks 9–16 to the Swap layer on the same fader strips.

---

**Layouts**

This section explains how to create a new *Layout* to store your assignments of Pro Tools tracks to strips.

**To create a new Layout:**

1 From the Main Panel, press the Layout key. The Layout Panel is displayed. The button next to the last recalled Layout is lit.

2 Press the New key at the bottom left of the Layout Panel. The New key flashes.

3 Select the channels to include in the new Layout by doing the following:
   - To select all console strips, press the ALL key at the bottom-right of the Layout Panel.
     - or –
   - To select individual strips, press the Wave key in each desired strip.

4 To save the new Layout, press the desired Layout key in the Layout Panel. The New key becomes unlit and the Name key lights. Unused locations are unlit and have a default name (such as “L 13”).

5 Use the console keyboard to name the new Layout.

*To learn how to recall, modify, rename, or delete a Layout, see the System 5 User Guide.*
Using the Transport

The Avid MachineControl™ Option is required to use the CM401 Machine control section to control the Pro Tools transport. When your Pro Tools workstation is attached and the MachineControl option is configured, the transport switches on System 5 control the Pro Tools Transport. You can use the System 5 Smart Switches for EUCON machine control. For Pro Tools these are on bank 10, or from the bank 1 TRANS key. EUCON track arming is done from the individual strip’s Link/Rec switch.

The System 5 uses the TT002 (single operator) or TT003 (dual operator) machine control interface. This provides one 9-pin, MIDI and LTC I/O (note, however, that this interface is not a synchronizer). The CM401 machine control section does not use EUCON commands. Source, Frame rate, track arming message length and FF/RW speed are controlled from the eMix System Preferences page. Record from the CM401 as well as track arming from the CM402 or CM403 post panel sends the appropriate machine control command to the designated master or record enabled machine (such as Pro Tools). Loop points (Return) are set using the Mark in/out keys. Loop points, as well as Roll Back time and Title start/end, can be entered manually into the System 5 Locate Registers.

System 5 Machine Control panel
1 RTZ (Return to Zero) Go to the Title Start Time entered in the Locate Registers.

2 Rewind Moves the play cursor earlier.

3 Fast Forward Moves the play cursor later.

4 Stop Stops playback.

5 Play Starts playback.

6 Record Toggles the Pro Tools Transport (master) record state on (armed) or off.

**Using the Transport Controls**

The following commands require the Avid MachineControl option on the Pro Tools workstation.

**Playback**

To play from the current location:
- Press **Play**.

To stop playback:
- Press **Stop**.

**Session Time Navigation**

To jump to the beginning of the session:
- Enter the Session Start Time in the System 5 CM401 Locate Registers.

To rewind or fast-forward:
- Press **Rew** or **FFW**.

💡 *Pro Tools provides preference settings to optimize rewind and fast forward (such as Audio During Fast Forward/Rewind, and Back/Forward Amount). For more information, see the Pro Tools Reference Guide.*

**Recording**

To record arm the Pro Tools Transport:
- Press **Record**.

💡 *For additional recording features, see Chapter 4, “Recording.”*
Navigating Through a Session

On System 5, you use Layouts to store and recall assignments of Pro Tools tracks to console strips. For instructions on how to create a new Layout and assign Pro Tools tracks, see “Assigning Pro Tools Tracks to Console Strips” on page 10. For complete information on how to recall, modify, rename, and delete layouts, and additional information on assigning tracks to strips, see the System 5 User Guide.

Fader Strip Controls

Fader strips let you adjust track volume, pan, solo, and mute Pro Tools tracks. (You can also control plug-ins and track automation. For plug-ins, see Chapter 5, “Plug-Ins and Sends.” For automation, see Chapter 6, “Automation and Mixing.”)

Adjusting Track Volume and Pan

This section shows how to adjust track volume and pan.

To adjust Pro Tools track volume:
1. Recall a Layout containing your Pro Tools tracks.
2. Press the Main or Swap key to bring that track to the strip.
3. Adjust the fader for that track.

To adjust track pan:
1. Press the PAN function key.
2. Rotate encoder 1 (Pan F) for the track you want to pan. Stereo tracks default to Left pan.

💡 System 5 strips offer many options for pan control that are available on the two pages of Pan settings in each strip. For more information, see the System 5 User Guide.

Using the Joysticks

To assign strips to the System 5 joysticks, there are two modes: cycle and direct. These modes are found in the CM401 Strips menu.

Cycle Assign Uses the strips wave key. For stereo Pro Tools channels, press the wave key twice (assigning the track to both joysticks), then use the right joystick up arrow to select the right paner.

Direct Assign Works the same way as strip assignment from the CM401 EUCON page.
Track Basics

This section shows how to select Pro Tools track input and output routing.

Selecting Tracks

To select a track:

1. Recall the Layout that contains the desired track.
2. Press any fader **Chan Select** key.

The track is selected in Pro Tools. You can use standard Pro Tools shortcuts in combination with the fader **Chan Select** keys to do the following.

To select all tracks:

- Hold Option (Mac) or Alt (Windows) on your computer keyboard and press any unlit track **Chan Select** key.

To deselect a track:

- Hold Command (Mac) or Start (Windows) on your computer keyboard and press a lit track **Chan Select** key.

To deselect all selected tracks:

- Hold Option (Mac) or Alt (Windows) on your computer keyboard and press any lit track **Chan Select** key.

To select a range of tracks:

1. Press the **Chan Select** key on the first track (usually, the left-most track you want to select).
2. Hold the Shift key on your computer keyboard and press the **Chan Select** key on the last (right-most) track. All tracks between the two are selected.

To select non-adjacent tracks (add to a selection):

1. Press and hold the **Chan Select** key to select the first desired track.
2. Press **Chan Select** on other strips.
Track Input and Output Routing

Routing Track Input and Output

These examples show how to assign Pro Tools track input and output from the console strip.

To assign Pro Tools track input:

1. Recall the Layout that contains your Pro Tools tracks.
2. Press the Input key in a CM401 knob cell. The lowest three knob cells display the top level of Input choices for Pro Tools tracks: no input, hardware, and bus.
3. Press the knob for the desired type of input:
   - To assign no input to the track, press the knob next to no input.
   - If you want to assign a hardware input to the track, press the knob next to hw I/O.
   - To assign a bus input to the track, press the knob next to busses.

If you selected hw I/O or busses, the screen displays the available hardware or bus inputs. If there are more than eight available choices for the selected input type, use the Page key to display the additional choices.
4. Press the knob for the desired input choice to assign it as the track input.

To assign Pro Tools track output:

1. Recall the layout that contains your Pro Tools tracks.
2. Press the Mix function key. The lowest three knobs display the top level of Output choices for Pro Tools tracks:
3. Press the knob for the desired type of output:
   - To assign no output to the track, press the knob next to no output.
   - If you want to assign an Output bus to the track, press the knob next to hw I/O. The knobs display available Output bus choices (such as Out 1-2) on the knobs. To see additional choices, press the PAGE key.
   - To assign an internal bus output to the track, press the knob next to busses. The knobs display internal bus choices on the knobs. To see additional choices, press the PAGE key.
4. When the desired output choice is displayed, press its knob.

Multiple Output Path Assignments

Pro Tools tracks can have multiple Main output paths assigned to them. When assigning track output from a EUCON unit, you can simply repeat the previous instructions and the new assignment will be added to the current assignments. When reassigning outputs, you must first assign no output, then assign the new output path.
When using System 5 to record audio to Pro Tools, configure machine control and track arming via EUCON. The track arming available in EUCON lets you control Pro Tools Track record enable switches; the System 5 Transport Record switch toggles the Pro Tools Transport Master (deck) record switch.

Transport functions require the Pro Tools MachineControl option for Sony 9-pin serial machine control. Once MachineControl is enabled and Pro Tools Track Arming configured, serial track arming can be done from the CM402 or the CM403 Post panel. For EUCON track arming, use the strips Link/Record key.

**Configuring the System for Pro Tools Recording**

Configure Pro Tools as a Sony 9-pin machine control device so that it will follow track and deck record commands from System 5 via Sony 9-pin. Your exact configuration settings may vary depending on the specific components of your system, so refer to the *Pro Tools Reference Guide* for instructions.


**Pro Tools QuickPunch, TrackPunch, and Destructive Punch Modes**

If you want to punch record into Pro Tools, use your mouse to enable the desired mode by selecting it in Pro Tools. Punch record modes are available in the Pro Tools Options menu. Pro Tools also provides Preference settings to optimize Punch recording for different situations and workflows. For details on how to configure and use punch recording, see the *Pro Tools Reference Guide*. 
This chapter explains how to assign and adjust plug-ins and sends (Auxes) on tracks.

When working with EUCON channels (such as Pro Tools tracks), Dynamics, EQ, Aux, and Monitor controls do not appear on the CM402. Use the controls in the individual channel strips instead.

Working with Plug-In Inserts

This section shows you how to work with Pro Tools plug-ins. Pro Tools tracks can have up to 10 inserts per track (in any combination of software plug-ins and hardware inserts).

Working with Plug-Ins

To access and edit a plug-in:

1. Recall the Layout containing the desired tracks.

2. Press the Star (*) key on a track to show currently assigned plug-ins.

If no plug-in is inserted in the current slot, the slot letter appears in lower-case (a, b, c, and so on). If any plug-ins are already assigned in the current slot, the name of the plug-in is shown. Plug-in names are abbreviated as necessary. For example, if the Compressor/Limiter 3 Dynamics plug-in is present in the current slot, the display above its track shows CmprsLD.

3. To view other insert slots, press PAGE > until that slot and any assigned plug-ins are displayed.

4. Press the Knob for the plug-in you want to edit.

The first page of parameters for that plug-in are mapped across the encoders.

5. Press PAGE > (or PAGE <) to access other parameters for the current plug-in.

6. Adjust parameters for the plug-in using the Knobs and associated keys.

If you are working with EQ or Dynamics plug-ins (such as a compressor, expander, or gate), see “EQ/DYN Keys and Standard Plug-In Mapping” on page 20.
Assigning Plug-Ins

To assign a plug-in:

1. Recall the Layout containing the desired track.

2. Press the * key on the strip containing the desired track.

3. Press both Config keys on the strip to enter Insert Assign mode. Insert slots are displayed on the Knobs (a, b, c, and so on), and both PAGE keys flash.

4. Press the encoder next to the desired insert slot a–j.

5. The Knobs now show the next level of choices (choices will vary depending on the system and session configuration, and on the mono/stereo/multichannel format of the current track and strip):
   - no insert
   - multichannel
   - multi-mono
   - I/O (for hardware inserts)

6. Press the Knob for the desired insert type. The Knobs now show the next level of choices (such as EQ, Dynamics, Reverb, and so on). Choices shown on your system will vary depending on which plug-ins you have installed, and the Pro Tools setting to organize plug-ins by Category or Manufacturer.

7. Press the Knob for the desired plug-in type. The Knobs show the available plug-ins in that category.

8. When the desired plug-in is displayed, press its Knob to insert it on the selected track.

9. Press both Config keys again to exit Insert Assign mode. Or select any other function (such as Pan or Aux).

Using the EQ and DYN Keys

You can use the EQ and DYN keys on to quickly access inserted EQ or dynamics plug-ins.

To access an EQ or Dynamics plug-in directly:

1. Recall a Layout containing a track with an EQ (or dynamics) plug-in inserted.

2. Press the strip EQ (or DYN) key. The Knobs show the functions of any inserted EQ or dynamics plug-ins, regardless of their slot location (a–f).

EQ/DYN Keys and Standard Plug-In Mapping

When you navigate to an EQ or Dynamics plug-in using the * key, the parameters are arranged across your hardware controls in a layout unique to that plug-in or to its manufacturer. The EQ and DYN keys are different. When either of these keys are pressed, they map plug-in parameters according to a standard control layout. This lets the controls appear in the same arrangement across your controller, regardless of the model or manufacturer.
Working with Sends

This section shows how you can assign and adjust Pro Tools sends.

💡 *System 5 hardware and documentation use the term “AUX” to refer to the Pro Tools term “sends.” Do not confuse references to “AUX” with Pro Tools Auxiliary Input tracks.*

Working with Sends

Assigning and editing Pro Tools sends (Auxes) from System 5 is similar to working with track input and output. In Pro Tools, each track can have as many as 10 send outputs assigned.

**To assign a send on a Pro Tools track:**

1. Recall the layout that contains your Pro Tools tracks.
2. Press the **Aux** key on a Pro Tools strip.
3. Press both **Config** keys to enter Aux Config mode. The lowest three knobs display the top level of send choices for Pro Tools tracks (no output, hardware, and busses).
4. Press the knob for the desired type of input:
   - To assign no send to the track, press the knob next to no output.
   - If you want to send to a hardware output, press the knob next to hardware.
   - To assign a bus send to the track, press the knob next to busses.
5. When the desired output choice is displayed, press its knob. If you chose no output, the knobs return to their previous state. If you chose hardware or bus, the screen displays a list of the available hardware or bus output paths.

When the desired Output or Internal bus path is displayed, press its Knob.

6. To see additional choices, press the **PAGE** key.
Multiple Send Output Path Assignments

Pro Tools sends (Auxes) can have multiple output paths assigned to them. When assigning Send output from a EUCON unit, you can simply repeat the previous instructions and the new assignment will be added to the current assignments. When reassigning Send outputs, you must first assign no output, then assign the new output path.

**To mute a send:**

1. Recall the Layout containing the desired track.
2. Press the **Aux** function key to show all Sends assigned on that strip’s track.
3. Press the bottom switch (On key) next to the desired Send. When muted, the key is unlit; when the send is on, the key is lit.

**To toggle the send between pre- and post-fader:**

1. Recall the Layout containing the desired track.
2. Press the **Aux** function key to show all Sends assigned on that strip’s track.
3. Press the top switch (Sel) next to the desired Send to toggle pre-/post-fader. When the switch is lit, it indicates the send is pre-fader; when unlit, the send is post-fader (sends default to post-fader).

**To adjust send pan:**

1. Recall the Layout containing the desired track.
2. Press the **Aux** function key to show all Sends assigned on that strip’s track.
3. Press the knob top (knob switch), then rotate the knob to adjust pan.
4. To exit Aux Pan mode, press **Aux** again.
chapter 6

Automation and Mixing

In System 5, the terms “Glide” and “Glide Modes” are analogous to the Pro Tools Touch and Latch terminology.

Global Pro Tools automation modes are accessed through the CM401 EUCON Smart Keys (or Soft Keys). From the Main Panel, select EUCON, then select SMRT. Navigate to the Automation page to access global automation modes and assign them to EUCON Smart Keys (see the System 5 User Guide for more information).

You can also select the automation mode for Pro Tools tracks from the console as explained below.

To select a Pro Tools automation mode for Pro Tools tracks from the console:

1. Recall the Layout containing the desired Pro Tools tracks.

2. Press the Wave key + Fader Select. The available Pro Tools track Automation modes are displayed on-screen.

3. Use the fader to scroll through the available track Automation modes (the currently selected mode is highlighted) such as Off, Read, and Write.

4. When asked to confirm, say Yes.

For complete information about Pro Tools automation, including other modes (such as Latch, Trim, and how to suspend/enable automation types), see the Pro Tools Reference Guide.